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What is git?

1. An unpleasant or contemptible
person. Often incompetent,
annoying, senile, elderly or
childish in character

2. A modern distributed version
control system with an emphasis
on speed and data integrity.
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Version Control Systems

o Version control systems (VCS) record changes to a file or set of files
over time so that you can recall specific versions later

VeT*E Version control software [hide]

Years, where available, indicate the date of first stable release. Systems with names in italics are no longer maintained or have planned end-of-life dates.

Free/open-source RCS (1982) - SCCS (1972)
Local only
Proprietary PVCS (1985) - QVCS (1991)

Free/open-source CVS (1986, 1990 in C) - CVSNT (1998) - QVCS Enterprise (1998) - Subversion (2000)

AccuRev SCM (2002) - ClearCase (1992) - CMVC (1994) - Dimensions CM (1980s) - DSEE (1984) - Endevor
(1980s) - Integrity (2001) - Panvalet (1970s) - Perforce Helix (1995) - SCLM (1980s?) -

Proprietary  Software Change Manager (1970s) - StarTeam (1995) - Surround SCM (2002) - Synergy (1990) - Team Concert
(2008) - Team Foundation Server (2005) - Visual Studio Team Services (2014) - Vault (2003) -
Visual SourceSafe (1994)

ArX (2003) - BitKeeper (2000) - Codeville (2005) - Darcs (2002) - DCV'S (2002) - Fossil (2007) | Git (2005)
GNU arch (2001) - GNU Bazaar (2005) - Mercurial (2005) - Monotone (2003) - Veracity (2010)

Client—-server

Free/open-source

Distributed
Proprieta TeamWare (1990s?) - Code Co-op (1997) - Plastic SCM (2006) - Team Foundation Server (via Git) (2013) -
PrIEIAY  \isual Studio Team Services (via Git) (2014)
e Baseline - Branch - Changeset - Commit - Data comparison - Delta compression - Fork (Gated commit) - Interleaved deltas - Merge -

Monorepo - Repository * Tag - Trunk

Category - Comparison - List

https://en.wikipedia.org/wiki/Version control



https://en.wikipedia.org/wiki/Version_control

Client-Server vs. Distributed VCS
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Client-server approach Distributed approach

Distributed version control systems (DCVS) allows multiple people to work
on a given project without requiring them to share a common network.



Subversion (SVN):
once the most popular client-server VCS

THE #1 PROGRAMMER EXCUSE
FOR LEGITIMATELY SLACKING OFF:

“The Subversion server’s down”

HEY! GETBACK ™
TO WORK!

http://tinyurl.com/distributed-advantages
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Git is now the most popular and free VCS!

THE #1 PROGRAMMER EXCUSE
FOR LEGITIMATELY SLACKING OFF:

“The Subversion server’s down”

HEY! GETBACK ™
TO WORK!

http://tinyurl.com/distributed-advantages

o Git offers:
= Speed
= Backups
= Offline access
= Small footprint
= Simplicity
= Social coding


http://tinyurl.com/distributed-advantages

Where did Git come from?

o Written initially by Linus Torvalds to
support Linux kernel and OS
development.

o Meant to be distributed, fast, and more
natural.

o Capable of handling large projects

o Now the most popular free VCS!

Images from Wikipedia



Why use Git?



Q. Would vtou. write your Llab boole in
pencil, then erase and overwrite it
every dav with new content?



Q. Would you write your Llab boole in
pencil, then erase and overwrite it
every dav with new content?

Version control is the lab notebook of the digital world:
it’s what professionals use to keep track of what they’ve
done and to collaborate with others.



Why use Git?
o Provides ‘snapshots’ of your project during development and

provides a full record of project history.

o Allows you to easily reproduce and rollback to past versions of
analysis and compare differences.
(Note: Helps fix software regression bugs!)

o Keeps track of changes to code you use from others such as fixed
bugs & new features

o Provides a mechanism for sharing, updating and collaborating
(like a social network)

o Helps keep your work and software organized and available.



Obtaining Git



Obtaining Git

o Check if git is already installed by typing ‘git’ in your Terminal

o If absent, download and install the latest version of Git at
https://git-scm.com/downloads

Downloads
Latest source Release
, i 2.22.0
@ Macosx ... Windows Release Notes (2019-06-07)
{ Linux/Unix Download 2.22.0 for Mac

Older releases are available and the Git source
repository is on GitHub.



https://git-scm.com/downloads

Configuring Git



Configuring Git

o First, tell git you you are
S git config --global user.name "Hyun Min Kang"
S git config --global user.email "hmkang@umich.edu"”

o Optionally, enable terminal colors
$ git config --global color.ui true



Using Git



Getting started with Git

1. Initiate a Git repository
2. Edit content (i.e. change some files)

3. Store a ‘snapshot’ of the current file state



Initiate a Git repository

~$ cd ~/ # choose a directory to start from
~$ mkdir git _class # make a new directory

~$ cd git_class # change to the new directory
~/git class$ git init # Our first Git command!

Initialized empty Git repository in
/Users/hmkang/git_class/.git/

~/git class$ 1ls -a # What happened?
. . .git

DOIT
YOURSELF

@




Side-Note: The .git/ directory

o Git created a ‘hidden’ .git/ directory inside your current working
directory

o You can use the ‘1ls -a’ command to list (i.e. see) this directory and
Its contents.

o This is where Git stores all its goodies — this is Git!

o You should not need to edit the contents of the .git/ directory for
now but do feel free to poke around.



Important Git commands

$ git status # report on content changes

$ git add «<filename> # stage/track a file
$ git commit -m “message” # snapshot




Important Git commands

$ git status # report on content changes

$ git add «<filename> # stage/track a file
$ git commit -m “message” # snapshot

You will use these three commands over and over in your Git workflow!




Git TRACKs your directory content

o To get a report of changes (since last commit), use:
S git status

o You tell Git which files to track with:

S git add <filename>

This adds files to so-called STAGING AREA
(akin to “shopping cart” before purchasing)

o You tell Git when to take a historical SNAPSHOT of your staged
files (i.e. record their current state) with:

$ git commit -m “message”




Example Git workflow

<

&

<

Create a README text file
(this starts as untracked)

Add file to STAGING AREA
(tracked and ready to take a snapshot)

Commit changes
(record snapshot of staged files!)



Example Git workflow

Create a README text file

Add file to STAGING AREA

Commit changes

Modify README and add a ToDo text file

Add both files to STAGING AREA

b T () [ Y (e

Commit changes



DOIT
YOURSELF

1. Create a README file

hmkang:~$ cd ~/git_class/

hmkang:git_class$ echo "This is the first line of text" > README Create a new file
hml.(ang:glt_clc'lss$ cgt README
This is the first line of text

[T RGO (] S
On branch| master

No commits yet

Untracked files:
(use "git add <file>..." to include in what will be committed)

nothing added to commit but untracked files present (use "git add" to track)
hmkang:git_class$




DOIT
YOURSELF

@

2. Add README file to ‘staging area’
hmkang:git_class$ git add REAE

hmkang:git_class$ git status

On branch master
Report on changes

No commits yet

Changes to be committed

(use "git rm --cached <file>..." to unstage)

new file: README

hmkang:git_class$



DOIT
YOURSELF

@

3. Commit changes

hmkang:git_class$ git commit -m "Create a README file"

[master (root-commit) [edlec4e] Create a README file
1 file changed, 1 insertion(+)

create mode 100644 README

hmkang:git_class$ git status

On branch master
nothing to commit, working tree clean
hmkang:git_class$




DOIT

4. Modify README and add ToDo file | vourses

hmkang:git_class$ echo "This is a 2nd line of text" >> README Add one more line to README

hmkang:git_class$ cat README —
This is the first line of text UNRlals

This is a 2nd line of text .
hmkang:git_class$ echo "Learn git basics" >> ToDo Create another file named ToDo

hmkang:git_class$ cat ToDo
Learn git basics Check the contents

hmkang:git_class$ git status

On branch master Report on changes

Changes not staged for commit:
(use "git add <file>..." to update what will be committed)
(use "git checkout -- <file>..." to discard changes in working directory)

Untracked files:
(use "git add <file>..." to include in what will be committed)

no changes added to commit (use "git add" and/or "git commit -a")
hmkang:git_class$




DOIT
YOURSELF

@

5. Add both files to ‘staging area’

hmkang:git_class$ git add README ToDo Add both files in one command
hmkang:git_class$ git status

On branch master Report on changes

Changes to be committed:
(use "git reset HEAD <file>..." to unstage)

modified: README
new file: ToDo

hmkang:git_class$




DOIT
YOURSELF

@

6. Commit changes

hmkang:git_class$ git conmit -m "Add ToDo and modify README"
[master [c147d@c]] Add ToDo and modify README Takelalsnapshot

2 files changed, 2 insertions(+)
create mode 100644 ToDo

hmkang:glt_class$ git status
On branch master i :

nothing to commit, working tree clean
hmkang:git_class$




Example Git workflow

Create a README text file

Add file to STAGING AREA

Commit changes

Modify README and add a ToDo text file

Add both files to STAGING AREA

b T () [Cp Y (e

Commit changes

... But, how do we see the history of our project changes?



DOIT
YOURSELF

@

git log : Timeline history of snapshots

hmkang:git_class$ git log
commit |c147dOcR@b77aa279959772387d6ee@8c1832187 (HEAD -> master)
Author: Hyun Min Kang <hmkang@umich.edu>

Date: Fri Aug 9 06:52:33 2019 -0400

Add ToDo and modify README

commit |edlec4eP983bd59c77cd7b3cce8b@ccfd501a726
Author: Hyun Min Kang <hmkang@umich.edu>
Date: Fri Aug 9 06:44:54 2019 -0400

Create a README file
hmkang:git_class$




DOIT
YOURSELF

@

git log : Timeline history of snapshots

hmkang:git_class$ git log
commit |c147dOcR@b77aa279959772387d6ee@8c1832187 (HEAD -> master)
Author: Hyun Min Kang <hmkang@umich.edu>

Date: Fri Aug 9 06:52:33 2019 -0400

Add ToDo and modify README

commit |edlec4eP983bd59c77cd7b3cce8b@ccfd501a726
Author: Hyun Min Kang <hmkang@umich.edu>
Date: Fri Aug 9 06:44:54 2019 -0400

Create a README file
hmkang:git_class$




Side-note: Git history is akin to a graph

o Nodes are commits labeled by their unique

‘commit ID’.

c147d0c (This is a CHECKSUM of the commits author, time,
commit msg, commit content and previous commit
D).

edlecde o HEAD is a reference (or ‘pointer’) to the currently

checked out commit (typically the most recent
commit).



Branching can complicate project graphs

Master Feature BugFix

cl47d00‘ ‘ abl740f

| --------- ‘ 59d63£1 I
......................................... b76995f
edlec4e‘ .................................... ‘

Branches allow you to work independently of other lines of development

we will talk more about these later!



Key points

o You explicitly and iteratively tell git what files to track (“git add”)
and snapshot (“git commit”).

o Git keeps an historical log (“git log”) of the content changes (and
your comments on these changes) at each past commit.

o Itis a good practice to regularly check the status of your working
directory, staging arena repo (“git status”)



Break



Important Git commands

$ git status # report on content changes

$ git add «<filename> # stage/track a file
$ git commit -m “message” # snapshot




Summary of key Git commands

$ git status # Get g status report of changes since last commit

$ git add «<filename> # Tell Git which files to track/stage
$ git commit -m “message” # Take acontent snapshot

S git log # Review your commit history

$ git diff <commit.ID><commit.ID> # Inspect content differences
$ git checkout <commit.ID> # Navigate through the commit history




Your 'Staging  Local
Directory  Area’ Repository

status




DOIT
YOURSELF

@

git diff: Show changes between commits

hmkang:git_class$ git diff edle c147

diff --git a/README b/README

index 1829919..af0ddb2 100644

o o/README cl47d0c <
+++ b/README

@@ -1 +1,2 @@

This is the first line of text

+This is a 2nd line of text

diff --git a/ToDo b/ToDo
new file mode 100644 edlecde @

index 0000000. .141fbd56
-—- /dev/null
+++ b/ToDo
@@ -0,0 +1 @@
+Learn git basics
hmkang:git_class$




DOIT
YOURSELF

@

git diff: Show changes between commits

hmkang:git_class$ git diff cl47 edle

diff --git a/README b/README

index af@ddb2..1829919 100644 cl47d0c ¢
—-—- a/README

++ b/README

@@ -1,2 +1 @@

This is the first line of text

diff --git a/ToDo b/ToDo

deleted file mode 100644 edlecde <
index 14fbd56. .0000000

-—- a/ToDo

++ /dev/null

@@ -1 +0,0 @@

hmkang:git_class$




DOIT
YOURSELF

@

git diff: Show changes between commits

hmkang:git_class$ git diff edle

diff --git a/README b/README Omitted second

index 1829919. .af0@ddb2 100644 argument implies c147d0c 4
——— a/README current “HEAD”

++ b/README

@@ -1 +1,2 @@

This is the first line of text
+This 1s a 2nd line of text
diff --git a/ToDo b/ToDo
new file mode 100644
index 0000000. .14fbd56 If first argument is omitted, it
--- /dev/null implies the last commit

+++ b/ToDo (i.e. git diff with no argument

@@ -0,0 fl ee . shows uncommitted changes
+Learn git basics since last commit)

hmkang:git_class$

edlecde o—



HEAD advances automatically with changes

o To move HEAD (back or forward) on the Git

graph (and retrieve the associated snapshot
c147d0c 4
content) we can use the command:

> git checkout <commit.ID>

edlecde



DOIT
YOURSELF

@

git checkout : moves HEAD

hmkang:git_class$ cat README

This is the first 1line of text
This is a 2nd line of text cl147d0c <

hmkang:git_class$ git log --oneline

c147d0c (HEAD -> master) Add ToDo and modify README
edlec4e Create a README file
hmkang:git_class$

edlecde



git checkout : moves HEAD
(e.g. back in time)

hmkang:git_class$ git checkout edle
Note: checking out 'edle'.

You are in 'detached HEAD' state. You can look around, make experimental
changes and commit them, and you can discard any commits you make in this
state without impacting any branches by performing another checkout.

If you want to create a new branch to retain commits you create, you may

do so (now or later) by using -b with the checkout command again. Example:

git checkout -b <new-branch-name>

HEAD is now at edlec4e Create a README file
hmkang:git_class$ cat README

This is the first line of text
hmkang:git_class$ git log --oneline

edlec4e (HEAD) Create a README file
hmkang:git_class$

DOIT
YOURSELF

cl47d0c

edlecde

) HEAD.




git checkout : moves HEAD

DOIT
YOURSELF

@

(e.g. back to the future!)

hmkang:git_class$ git checkout master

Previous HEAD position was edlec4e Create a README file

Switched to branch 'master’ cl47d0c
hmkang:git_class$ git log --oneline

c147d0c (HEAD —> master) Add ToDo and modify README

edlec4e Create a README file

hmkang:git_class$ cat README

This is the first line of text

This is a 2nd line of text edlecde
hmkang:git_class$

) HEAD.




Side-Note : two main ways to use git checkout

o Checking out a commit makes the entire working directory match
that commit. This can be used to view an old state of your project.

> git checkout <commit.ID>

o Checking out a specific file lets you see an old version of that
particular file, leaving the rest of your working directory untouched.

> git checkout <commit.ID> <filename>



You can discard revisions with git revert

o Thegit revert command undoes a committed snapshot.

o But, instead of removing the commit from the project history, it

figures out how to undo the changes introduced by the commit and
appends a new commit with the resulting content.

> git revert <commit.ID>

o This prevents Git from losing history!



Removing untracked files with git clean

o Thegit clean command removes untracked files from your working
directory.

o Like an ordinary rm command in UNIX, git clean is not undoable, so
make sure you really want to delete the untracked files before you run it.

git clean -n # dry run display of files to be ‘cleaned’
git clean -f # remove untracked files



GUIs

o Tower (Mac, Windows)

o GitHub_Desktop (Mac, Windows)
o SourceTree (Mac, Windows)

o SmartGit (Linux)

o RStudio

See https://git-scm.com/downloads/guis more details



https://git-scm.com/downloads/guis

Side-Note : Using Git with RStudio

o Two initial steps within Rstudio
= Tools > Global Options > Git/SVN
" File > New Project > New Directory > Empty Project

New Project

Back Create New Project

Directory name:

RStudioGitTest
Create project as subdirectory of:

/Volumes/GoogleDrive/My Drive/class/BIOSTAT606

v Create a git repository

Open in new session Create Project

Browse...

Cancel

Options

General
Code

| Appearance
Pane Layout
Packages

R Markdown

@ sweave

ABC
v

Spelling

W Git/swN

"_:/- Publishing

- Terminal

v/ Enable version control interface for RStudio projects

Git executable:

/usr/bin/git Browse...
SVN executable:

/usr/bin/svn Browse...
SSH RSA Key: View public key
~/.ssh/id_rsa

Create RSA Key...

?) Using Version Control with RStudio



Summary

o Gitis a popular ‘distributed’ version control system that is
lightweight and free

o Introduced basic git usage and encouraged you to adopt these ‘best
practices’ for your future projects

o Next lecture we will cover GitHub and BitBucket, two popular hosting
services for git repositories that have changed the way people
contribute to open source projects



Learning Resources

o Try Git. Overrated hands-on git tutorial in your browser.
https://try.github.io/levels/1/challenges/1

o Set up Git. If you will be using Git mostly or entirely via GitHub, look
at these how-tos.
https://help.github.com/categories/bootcamp

o Getting Git Right. Excellent Bitbucket git tutorials
https://www.atlassian.com/git/

o Pro Git. A complete, book-length guide and reference to Git, by Scott
Chacon and Ben Straub
http://git-scm.com/book/en/v2



https://try.github.io/levels/1/challenges/1
https://help.github.com/categories/bootcamp
https://www.atlassian.com/git/
http://git-scm.com/book/en/v2

